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1. General Description

This user guide is intended to assist the users in evaluating the module by providing instructions on how to
effectively use the evaluation kit.

The BDE-MB1354P101 is a multi-band Sub-1GHz and 2.4GHz wireless module supporting Thread, Zigbee®,
Bluetooth® 5.2 low Energy, IEEE 802.15.4g, IPv6-enabled smart objects (6LoWPAN), mioty, Wi-SUN, Amazon
Sidewalk, proprietary systems including Tl 15.4-Stack (Sub-1GHz and 2.4GHz), and concurrent multiprotocol
through a Dynamic Multiprotocol Manager (DMM) driver.

The kit includes a breakout board with module (board number: BDE-MB13-BO), a Launchpad™ evaluation
module which can connect with the breakout board through the BoosterPack™ interface (board number: BDE-
LPEM), and also a XDS110 debugger used for debugging BDE-MB1354P101 device (board number: BDE-XDS110).

2. Launchpad Evaluation Module: BDE-LPEM

The BDE-LPEM is an evaluation module designed as an interface module with BoosterPack interface which can
connect with any boards that come with the standard BoosterPack interface, including the BDE-MB13-BO board.
For more details on the BoosterPack pinout standard, please refer to this link.

The board overview is shown as Figure 1.

XDS110 Interface
2x10P 2.54mm Pitch

e d4444494

O s 00 GO e

S woofe

22288288

o o' o (-]

[C] (CIN [c]
Buttons and LEDs Al il e el XDS110 Interface
Jumpers I 2x5P 1.27mm Pitch

RUEC|pmr . ™"

1440 20 53
GRED/PWM/GPO 7.

RLED/PWM/GPIO &

BoosterPack

Interface Interface

BoosterPack h

BDE-LPEM

Figure 1. Board Overview of BDE-LPEM
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3. Breakout Board: BDE-MB13-BO

We provide a breakout board for module to enable easy access to every exposed pad on module with the
2.54mm-pitch pins. The breakout board can be stacked to the BDE-LPEM board for evaluation.
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Figure 3. The Photo of BDE-LPEM Stacked with the Breakout Board with Module

3.1. Breakout Board Header Pin Assighment

Table 1 shows the pin assignment for breakout board header J1, J2, J3 and J4.

Table 1. Breakout Board Headers Pin Assignment
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Pin Number | Pin Name Type/Direction | Description

1 3v3 Power Board power supply, connect with module VDD through a ferrite
bead

2 DIO23 I/0 GPIO

3 DIO12 1/O GPIO, module RX in BoosterPack pin

4 DIO13 1/O GPIO, module TX in BoosterPack pin

5 DIO22 I/0 GPIO

6 DI024 I/0 GPIO

7 DIO10 I/0 GPIO, SPI_CLK in BoosterPack pin

8 NC - No connect

9 DlO21 I/0 GPIO, 12C_SCL in BoosterPack pin

10 DIOS I/0 GPIO, 12C_SDA in BoosterPack pin

11 NC - No connect

12 DIO14 I/0 GPIO, Button 2 in BoosterPack pin

13 DIO15 I/0 GPIO, Button 1 in BoosterPack pin

14 DIO8 I/0 GPIO, SPI_MISO in BoosterPack pin

15 DIO9 I/0 GPIO, SPI_MOSI in BoosterPack pin

16 nRST Input Reset pin, active low

17 NC - No connect

18 DIO11 I/0 GPIO, SPI_CS in BoosterPack pin

19 DIO19 I/0 GPIO

20 GND GND Board ground

21 NC - No connect

22 GND GND Board ground

23 DIO25 I/0 GPIO

24 DIO26 I/0 GPIO

25 DIO027 I/0 GPIO

26 DI028 - No connect

27 DIO29 - No connect

28 DIO30 I/0 GPIO

29 NC - No connect

30 NC - No connect

31 DlO17 I/0 GPIO

32 DlO16 I/0 GPIO

33 TCK - TCK for JTAG/XDS110

34 T™MS - TMS for JTAG/XDS110

35 NC - No connect

36 DIO18 I/0 GPIO

37 NC - No connect

38 DI020 1/O GPIO, PWM/GPIO in BoosterPack pin

39 DIO6 I/0 GPIO, RED LED in BoosterPack pin

40 DIO7 I/0 GPIO, Green LED in BoosterPack pin

BDE Technology Inc.
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3.2. Debug Header Pin Assignment
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Figure 4. Debug Header

Table 2 shows the pin assignment for the debug header.
Table 2. Debug Header Pin Assignment

Pin Number Pin Name | Type/Direction | Description

1,2,8,14,20 GND GND Board ground

3 5V Power 5V supply from XDS110

4,6,12, 16, 18 NC - No connect

5 3v3 Power Module power supply

7 RXD Input Module UART RXD

9 TXD Output Module UART TXD

10 SwWo I/0 SWO for JTAG

11 nRST Input Reset pin, active low

13 ™S I/0 TMS for JTAG/XDS110, or SWDIO for SWD debug
15 TCK I/0 TCK for JTAG/XDS110, or SWDCK for SWD debug
17 TDO I/0 TDO for JTAG/XDS110

19 TDI I/0 TDI for JTAG/XDS110

BDE recommends using XDS110 for the debug. J-Link or other debuggers support SWD could also work.

Figure 5. BDE-XDS110
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The board can also be connected via a 2x5P 1.27-pitch ribbon cable to the XDS110 debugger.

4. Getting Started

Below section describes how to set up the development environment of BDE-MB1354P101xx module, including
the hardware and software.

4.1. Prerequisites

4.1.1. Hardware

e BDE-MB13-BO, breakout board with module BDE-MB1354P101xxx, depending on what module variant you
are choosing;

e BDE-LPEM, Launchpad evaluation interface module;

e BDE-XDS110, XDS110 debugger;

e USBtype Ccable;

e PC

4.1.2. Software and Tools

e Code Composer Studio
e SIMPLELINK-LOWPOWER-F2-SDK
e SimplelLink Connect mobile app

e UniFlash
e SmartRF Studio
e PuTTY

BDE Technology Inc. 7148 info@bdecomm.com
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4.2. Hardware Setup

1. Plug BDE-MB13-BO into the BDE-LPEM evaluation module and connect BDE-LPEM to BDE-XDS110, as shown
in Figure 6;

2. Connect the jumpers as shown in Figure 6;

3. Connect the BDE-XDS110 to the PC via a USB type C cable. The XDS110 will power the module with 3.3V if the

jumper on BDE-XDS110 is plugged to XDS.

Figure 6. Hardware Setup

4.3. Software Setup

4.3.1. Download and Install CCS

1. Visit the following link.
https://www.ti.com/tool/CCSTUDIO
2. Find CCSTUDIO item, and click “Download options”.

Downloads

IDE, CONFIGURATION, COMPILER OR DEBUGGER
CCSTUDIO — Code Composer Studio™ integrated development environment (IDE)

Supported products & hardware A Notifications

3. Choose the target platform, in this case, Windows is selected.

BDE Technology Inc. 8 /48 info@bdecomm.com
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Downloads  Supported products & hardware

4 Windows single file (offline) installer for Code Composer Studio IDE (all features,

devices) — 025037 K MD5 checksum  03bed76dcd6af85babds789c6500d70f (R
& Linux single file (offline) installer for Code Composer Studio IDE (all features,

devices) — 1017375 K MD5 checksum  3bB5c52574e07f18028b3f406d28d266 R
4 mac0s single file (offline) installer for Code Composer Studio IDE (all features,

devices) — 1132582 K MDS5 checksum  dda2478c5250cf79e877c94136177211 (R

4. Decompress the zip file, and double-click “ccs_setup_xx.exe”.

Mame

components
G ccs_setup_20.1.0.00006
|Z| timestamp

5. Click “Next”.

i Code Composer Studio Setup

Code Composer Studio Setup - CCS 20.1.0.00006

Welcome to the CCS 20.7.0.00006 Setup Wizard.

89

code composer™
STUDIO

< Back

Cancel

6. Select “l accept the agreement”, and then click “Next”.
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G Code Composer Studio Setup - x

License Agreement Q

Please read the following License Agreement. You must accept the terms of this agreement before continuing with the installation.

TECHNOLOGY SOFIWARE PUBLICLY AVAILRELE

Copyright (c) 201€ Texas Instruments Incorporated
211 rights reserved not granted herzein.
Limited License Agreement.

This Limited License Agreement ("Rgreement™) is a legal agreement between you (either an indiwvidual or
entity) and Texas Instruments Incorporated ("TI"™). The "Scftware" consists of the following materials: (a)
the materials identified as TI proprietary software programs in the software manifest for the software
subject to the terms herein, and any "on-line" or electronic documentation associated with these programs, or
any portion thereof (the "Licensed Materials"™), and (b) the materials identified as open source materials or
third party proprietary software in the software manifest for the Software, or any portion thereof ("Public
Software™). For clarificatiom, your use of the Licensed Materials is subject to the licensing terms
contained in this Agreement and your use of the Public Software is subject to the separate licensing terms
specified in the applicable software manifest and/or identified or included with the materials to which they
apply. This Agreement does not limit your rights under, or grant you rights that supersede, the license

Do you accept this license? I =
4 3 (O I do not accept the agreement

< Back | Mext > I Cancel

7. Click “Next”.

§P Code Composer Studio Setup — X

Please read the information carefully to determine if you need to take any action prior to continuing. h

Operating System Check -> OK

Installer Path Check -> OK

Unicode Character Check -> 0K

Anti-virus Check -> We have detected you are running anti-virus software on this computer. Anti-virus real-time file scanning may interfere with
installation and it is recommended you temporarily disable this feature. Anti-virus software may also block the downloading of files that occurs
during installatien. If you cannot disable the anti-virus software, we recommend the offline installer, which has less interference.

< Back Cancel

8. Choose the installation directory, and then click “Next”.
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9.

§P Code Composer Studio Setup

Installation Directory

Installation Directory

Please specify the directory where CCS 20.1.0.00006 will be installed.

| g

Select “Wireless connectivity” components, and then click “Next”.

&8 Code Composer Studio Setup

Select Components

Select the components you want to install; clear the components you do not want to install. Click Next when you are ready to continue,

[] MSPMD Arm® Cortex ®-M0+ micrecontrollers

] MSP430™ microcontrollers

C2000™ real-time micrecontrollers

L Arm®-based processors

[[] AM2x Arm @-based high perfermance microcontrollers
[ mmWave Sensors

[] Hercules™ Safety MCUs

[ TM4C12x Arm® Cortex @ -Md4F MCUs

[ ceooo Power-Optimized DSP

[] OMAP-L1x DSP + Arm3™ Processor

[] SimpleLink™ MSP432™ low power + performance MCUs
[] PGA Sensor Signal Conditioners

[J uco Digital Power Controllers

Click on a component to get a detailed description

10. Click “Next”, and the installation will start. Wait until the installation is complete.

BDE Technology Inc.
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§9 Code Composer Studio Setup

Ready to Install uoﬂ

Setup is now ready to begin installing CCS 20.1.0.00006 on your computer.

< Back Cancel

11. Click “Finish”.

§P Code Composer Studio Setup

Completing the CCS 20.1.0.00006 Setup Wizard

Setup has finished installing CCS on your computer,

Create Desktop Shortcut
[ Launch CCS

89

code composer™
SsTUDIO

< Back | Finish | Cancel

4.3.2. Download and Install SDK

1. Visit the following link.
https://www.ti.com/tool/download/SIMPLELINK-LOWPOWER-F2-SDK

2.  Find “SIMPLELINK-LOWPOWER-F2-SDK"” item, and click “Download options”.

BDE Technology Inc. 12 | 48 info@bdecomm.com
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SOFTWARE DEVELOPMENT KIT (SDK)
% SIMPLELINK-LOWPOWER-F2-SDK — SimpleLink™ Low Power F2 software =

development kit (SDK) for the CC13x1, CC13x2, CC13x4, CC26x1, CC26x2 and
CC26x4 devices A Notifications

The SimpleLink™ Low Power SDKs support the CC13xx, CC23xx and CC26xx family of products. Together, these SDKs
provide comprehensive software packages for the development of Sub-1 GHz and 2.4 GHz applications including
support for Bluetooth® Low Energy, Mesh, Zighee®, Matter, Thread, 802.15.4-based, (...)

Supperted products & hardware

3. Choose the target platform, in this case, Windows is selected.

Downloads  Supported products & hardware

4 windows Installer for SimpleLink CC13XX CC26XX SDK — 817328 K

Checksum 6bfgbfod0ed1dbedf3ae256f127aeeff ™

I«

Linux Installer for SimpleLink CC13XX CC26XX SDK — 841416 K
Checksum 9e8c13c6120f4f5f7f0854b7127d824b Fn

I«

Mac 08 Installer for SimpleLink CC13XX CC26XX SDK — 798418 K
Checksum 2cbf4c3a2e2d703a0d4b5ac3195d14fc I

I«

windows Zipfile for SimpleLink CC13XX CC26XX SDK — 1591218 K
Checksum dc5699f56b18e50d4e5f8ddcag0ddede I

I«

Mac 08 Zipfile for SimpleLink CC13XX CC26XX SDK — 1578922 K
Checksum 2c5f6183848bc138d31d0db6fa3720ds Fn

I«

Linux Zipfile for SimpleLink CC13XX CC26XX SDK — 1605828 K
Checksum 1c8f736a65326a65bb39406dd9d1ba77 I

4. Double-click the installation package.
5. Click “Next”.

* Setup — O >

Setup - Simplelink Low Power F2 SDK 8.30.01.01

Welcome to the Simplelink Low Power F2 SDK 2.30.01.01
Setup Wizard.

< Back Mext = Cancel

6. Select “l accept the agreement”, and then click “Next”.
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* Setup — O >

License Agreement ”

Please read the following License Agreermnent. You must accept the terms of this
agreement before continuing with the installation.

e
Copyright (c) 2015-2024, Texas Instruments Incorporated
211 rights reserved not granted herein.
Limited License.
Texas Instruments Incorporated grants a world-wide, royvalty—free,
non—-exclusive license under copyrights and patents it now or
herseafter e

I@ ‘| accept the agreement; I

Do you accept this license?
| do not accept the agreement

< Back Mext = Cancel

7. Choose the installation directory, and then click “Next”. Make sure the installation directory does not include
non-ASClI characters or spaces.

* Setup — O >

Installation Directory ”

Please specify the directory where Simplelink Low Power F2 SDE 8.30.01.01 will be installed

The following directories will be created in this directory:

simplelink_ccl3xx_cc2Bxx_sdk_8_30_.01_0
sysconfig_1.21.1
xdctools_3_62_01_15_core

Installation Directory

< Back Mext = Cancel

8. Click “Next”, and the installation will start. Wait until the installation is complete.
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* Setup — O x

Ready to Install ”

Setup is now ready to begin installing SimpleLink Low Power F2 5DK 8.30.01.01 on your
computer,

< Back Cancel

9. Click “Finish”.

Completing the Simplelink Low Power F2 SDK
8.30.01.01 Setup Wizard

INSTRUMENTS

Setup has finished installing SimpleLlink Low Power F2 5DK
8.30,01.01 on your computer,

< Back

4.4. BLES5-STACK

This section describes how to use the BLE5-Stack projects with CCS.

The BLE5-Stack examples are located at
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30_01_01\examples\rtos\LP_EM_CC1354P10_1\ble5stack

BDE Technology Inc. 15 | 48 info@bdecomm.com
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4.4.1. Import Project into CCS

1. Open the CCS IDE.
2. Go to File -> Open Folder.

File Edit " \ Go Project Run Scripts Terminal Help

@

Ctril+N
Ctri+Alt+N

New Fo

Open File... Ctri+0
Open Folder... Ctrl+K, Ctr+O
space from File... Ctrl+Alt+W

Ctri+Alt+R

Ctrl+5S

Ctri+Alt+S

3. Select a custom path as the workspace.

&8 Open Folder x
N <« ccs_workspace » BDE-MB13534P107xx w Search BDE-MB1354P107xx el

Organize « MNew folder == o

@ OneDrive ~ MName Date modified Type

3 This PC No items match your search.
J 3D Objects
[ Desktop
|=| Documents
" Downloads

J‘! Music

&=| Pictures

m Videos

e Local Disk (C:)

< >

Folder: |

Select Folder Cancel

4. Go to File -> Import Project(s).
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File | Edit Selecti View Go Project Run Scripts Terminal Help

5 import Project(s

New Text File Ctri+N

Ctri+AR+N

)ser Stu

Ctrl+0
Ctrl+K, Ctrl+O
1+Al+W

Ctri+AR+R

zonnect your board

Ctrl+Alt+S

udio™ IDE

5. Click “Browse”, navigate to the “simple_peripheral” project folder. The default path is:
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30 01 _01\examples\rtos\LP_EM_CC1354P10_1\ble5stack\simple
peripheral

6. Select the project, and click “Finish”.

Import Projects

earch directory ~ Cti\simplelink_cc13xx_cc26xx_sdk_8_30_01_01\examples\rios), Browse

B3 simple_peripheral LP_EM_CC1354P10_1_tirtos7_ticlang

Create each project in: ccs_workspace v

Open’ ' to browse and import example projects

Cancel Fimish

7. The “simple_peripheral” project will be imported into the IDE.
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~ BDE-MB1354P101XX
~ EL,simple_peripheral_LP_EM_CC1354P10_1_tirtos?

> B3, Generated Source
> B9 Application

» B common

4.4.2. Modify XOSC Cap Setting

The “XOSC Cap Array Delta” parameter will impact the radio frequency offset. An inappropriate value can affect
the RF performance. Follow the steps below to set the value that fits the module.

1. Open “simple_peripheral.syscfg” file by double-click it.
Select the “Device Configuration” item. Modify “XOSC Cap Array Delta” to 0x00.

MCUboot
Force VDDR O
Device Configur... 1/1 Enable DCDC
LF XOSC

RF Design
ray Modification

Board I XOSC Cap Armray Delta 0x0

Display /3 Source 48 MHz X0SC_HF

DMA ! rature Com tio |
GFIO 9

3. Save the changes.

4.4.3. Modify RF Switch Configuration

The BDE-MB1354P101 module uses a different RF switch design compared to Tl LP-EM-CC1354P10-1. Follow the
steps below to adjust the RF configuration to fit the module.

1. Open syscfg file.
2. Select “RF” item under “TI DRIVERS”. Modify the RF settings according to the following diagram.
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RF &

None

Use Hardware A\ The board *10 LaunchPad Band 1" requires t

RF Antenna Switch' to be select
No. of Antenna Switch Control Pin:
RF Coexistence
Hardware Interrupt Priority 7 - Lowest Priority
Software Interrupt Priority 0 - Lowest Priority

X0SC Needed

RF_GlobalEventRadioPowerDown, RF_Globe

Global Event Mask

Global Callback Function

RF Pin Symbols

RF Antenna Pin 0 CONFIG_RF_ANTENNA_PIN_HIGH_PA
RF Antenna Pin 1 CONFIG_RF_ANTENNA_PIN_SUB_1_G

PinMux Peripheral and Pin Configuration

RF Antenna Pin 0

RF Antenna Pin 1

3. Save the changes.

4. Right-click the “Startup” folder in the project and create a new C file named “user_rf_switch_cfg.c”.

» E3,Release
~ 3 Startup

main.c

Mew File...

. Mew Folder...
osal_icall_
I Add Files/Folders...
s rom_init.c

B3
simple_peripheral_LP_EM_CC1354P10_1_tirtos7_ticlang/Startup

user_rf_s _cfg.c

5. Copy the following source code to user_rf_switch_cfg.c.
#include <stddef.h>

#include <stdint.h>

#ifndef DeviceFamily CC13X4

#tdefine DeviceFamily CC13X4
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#endif

#include <ti/devices/DeviceFamily.h>
#include "ti_drivers_config.h"
#include <ti/drivers/GPIO.h>
#include <ti/drivers/rf/RF.h>

/*
* ======== Antenna switching ========
*/
/*
* ======== rfDriverCallbackAntennaSwitching ========

* Sets up the antenna switch depending on the current PHY configuration.

* Fit BDE-MB13P2 module's switch

* Truth table:

* Path DIO29 DIO30
¥ ——======== ===== =====
* Off ) )

* TX 1 )

* RX ) 1

*/

void rfDriverCallbackAntennaSwitching(RF_Handle client, RF_GlobalEvent events, void *arg)

{

if (events & RF_GlobalEventRadioSetup) {
bool sub1GHz = false;

uint8_t loDivider = ©;

/* Switch off all paths. */
GPIO write(CONFIG_RF_ANTENNA PIN SUB_1 G, 0);
GPIO write(CONFIG_RF_ANTENNA PIN HIGH PA, 0);

/* Decode the current PA configuration. */

RF_TxPowerTable_PAType paType = (RF_TxPowerTable_PAType)RF_getTxPower(client).paType;

/* Decode the generic argument as a setup command. */

RF_RadioSetup* setupCommand = (RF_RadioSetup*)arg;

switch (setupCommand->common.commandNo) {
case (CMD_RADIO_SETUP):
case (CMD_BLE5_RADIO_SETUP):
loDivider = RF_LODIVIDER_MASK & setupCommand->common.loDivider;
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/* Sub-1GHz front-end. */
if (loDivider != @) {
sublGHz = true;
}
break;
case (CMD_PROP_RADIO DIV _SETUP):
loDivider = RF_LODIVIDER_MASK & setupCommand->prop_div.loDivider;

/* Sub-1GHz front-end. */

if (loDivider != @) {
sublGHz = true;

}

break;

default:break;

if (sublGHz) {
/* Sub-1 GHz */
if (paType == RF_TxPowerTable_HighPA) {
/* PA enable --> HIGH PA
* LNA enable --> Sub-1 GHz
*/
/* Note: RFC_GPO3 is a work-around because the RFC_GPO1l (PA enable signal) is sometimes not
de-asserted on CC1352 Rev A. */
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN_SUB 1 G, GPIO_CFG_OUTPUT, IOC_PORT_RFC_GP0®);
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA PIN_HIGH_PA, GPIO_CFG_OUTPUT, IOC_PORT_ RFC_GPO3);
} else {
/* RF core active --> Sub-1 GHz */
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN_HIGH_PA, GPIO_CFG_OUTPUT, IOC_PORT_GPIO);
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA PIN_SUB_1 G, GPIO_CFG_OUTPUT | GPIO_CFG_OUT_HIGH,
I0C_PORT_GPIO);

}

}
else if (events & RF_GlobalEventRadioPowerDown) {

/* Switch off all paths. */
GPIO write(CONFIG_RF_ANTENNA PIN SUB_1 G, 0);
GPIO write(CONFIG_RF_ANTENNA PIN HIGH PA, 0);

/* Reset the IO multiplexer to GPIO functionality */
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN_SUB 1 G, GPIO_CFG_OUTPUT, IOC_PORT GPIO);
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN_HIGH_PA, GPIO_CFG_OUTPUT, IOC_PORT GPIO);
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4.4.4. Build and Download Project

1. Select Project -> Build All to build the application project.
File Edit Selection View Go Project Runm  Scripts Terminal Help
@ EXPLORER Build All
_ #% Build Project(s) Ctrl+B
> OPEN EDITORS
Clean Project(s)

~ BDE-MB1354P101 XX
Rebuild Project(s)

~ F_=', simple_penipheral_LP_EM_CC

> Bl Generated Source Build Configurations
> B3 Application System Configurations
> B3 common
» B3 Drivers

» B icall = Properties... Alt+Enter

Executable Actions

2. After building successfully, select Run -> Debug to download the application to the module. If the following
message occur, click “Update”.

Loading Program:
ChUsers\bdeLihAppData\LocalTemp\ti_cloud_storage\simple_peripheral_LP_EM
S54P10_1_tirtos7_ticlang.out: PFT_LOAD[0]: 32752 of 169940 at 0x0

Cancel

Texas Instruments XD5110 USE Debug Probe/CS_DAP_0 Warning: A
3.0
| ith this
the firmware. DO NOT UNPLUG THE DEBUG PROBE DURING THE UPDATE.
{Emulation package 20.1.0.3372)

Cancel Update

3. After the update process is finished, click “Continue”.

DEBUG

Fa

4.4.5. Running the Demo

1. Open PuTTY, open the serial port with the following settings:
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&2 PuTTY Configuration ? >
Category:
=l Sgassiu:un Basic options for your PuTTY session
- Ten I..Dglging Specify the destination you want to connectin
=} Terminal —
- Keyboard Serial line Speed
- Bel \comi11] | 115200
- Features Lonnectiop fype:
=+ Window OssH | @ Senal |O0ther: | Telnet v
- Appearance
- Behaviour Load, save or delete a stored session
- Translation Saved Sessions
- Selection | |
i Colours
- Connection Load
- Data
- Proy Save
- 55H
: . Delete
- Senal
- Telnet
- Rlogin
- SUPDUP Close window on exit:
(O Mways () Mever (@) Only on clean exit
About Help COpen Cancel

The COM number can be found in the System Device Manager:

i XDS110 Class Application/User UART (COM111)
ALSTITU Ulass Awahary Lrata Fort (LURNTTL]

2. Debug the project and click “Continue” in CCS. The demo will begin execution. The PuTTY will display the
menu as shown below:

3. Open SimpleLink Connect mobile app. Click “Enable BluetoothLE Scan”, and you will see that the module is
advertising.
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Scanner :

Enable BluetoothLE Scan

B/
Available devices: 27
Simple Peripheral _
ﬂ D: 856ETCE1-3A4D-DEEC-BCEL-2FAIDOZFDAEZ -l.II 26 >

@ Advertising =

4. Click the right arrow on the right of “Simple Peripheral” item to connect to the module. After a successful
connection, you will see PUTTY update the information.

5. Select “TI Simple Peripheral Service”.

Available services: 2

Device Information

Tl Simple Peripheral Service

- -.|--: _ »

5 characteristics

6. Enable the notification of “Characteristic 4”, the app will receive notification sent by the module.

Characteristic 4

UUID: OxFFF4
Praperties: Natify

Motifications Enable )

03
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7. Write “05” to “Characteristic 3”. PUTTY will print the write information.

Characteristic 3
UUID: OxFFF3

Properties: Write

Write

05

4.5. Host_test Project & Btool Software

Tl provides a PC tool called “btool” to help developers simplify development. Developers can use Btool to scan
and connect to peripheral devices, or to send raw HCI commands.

The directory for Btool is:
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30 _01_01\tools\ble5stack\btool.

Before using Btool, the module must have the host_test application flashed onto it first.

The project directory for host_test is:
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30 01 _01\examples\rtos\LP_EM_CC1354P10_1\ble5stack\host_test.

Before building the host_test project, developers should perform the additional steps mentioned in sections 4.4.2
and 4.4.3.

The module will enter DTM mode once the host_test application is flashed. Btool can connect to the module
through UART interface.

The pins used by UART can be found in the following diagram:
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@ simple_peripheralsyscfg X

& = Software » UARTZ

Board Global Parameters  Settings that affect all instances
Display
DMA UART2 (1 Added)
GPIO

GPTimer
Power
PWM

RF Use Hardware

@

CONFIG_DISPLAY_UART

@®

Name CONFIG_DISPLAY_UART

@

RNG
Temperature

Enable Nonblocking Mode

Timer
TRNG
Watchdog

Flow Control

®
@

Interrupt Priority st Priority
RX Ring Buffer Size

TX Ring Buffer Size

TX Interrupt FIFO Threshold

RX Interrupt FIFO Threshold

PEERE®

PinMux Peripheral and Pin Configuration
UART Peripheral

ADCBuf
DAC

TX Pin /4 (XDS110 UART))

PO

RX Fin (XDS110 UART))

The following steps demonstrate how to operate Btool.
1. Open Btool.
2. Open the serial port with the following settings, and make sure the correct port is selected.

®p Serial Port Settings e
Port: | COMIT1 w
Baud: | 115200 ~
Flaw: | None o
Party: | Mone w
Stop Bits: | One e
Data Bits: |8 w

3. If the hardware functions properly, the following UART logs will be printed.
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[1] : <Info> — 02:40:25_158
Fort opened at 2024/10/22 14:40:25

2] : «T=>» — 02:40:25.237
-Tyvpe : 0201l (Command)
—CplCode : OxFC1D (HCIExt ResetSystemCmd)
—-Data Length : 0xd1 (1) byte(s)

Type o 0=dd (0) (Chip Reset)
Duamp {Tx) =
QoQo:Ql 1D FC OL QO .
[3] : <Rx> - 0Z2:40:25.3584

-Type : 0xd4 (Ewvent)

—EventCode : Ox00FF (HCI_LE ExtEvent)

-Data Length : 0xd5 (5) bytes(s)

Event : 0x041D (1053) (HCIExt ResetSystemCmdDone)
Status : 0x00 ({0) (SUCCESS)

CmdCpCode : OxFC1D (HCIExt ResetSystemilmd)

Dump (Rx) -

QoQo:04 FF O5 1D O4 QO 1DFPC ..

[4] : <Tx= — 02:40:25.903
-Type : 0x01l (Command)
—OpCode : OxFEOO (GAFP_Devicelnit)
-Data Length  0x02 (2) byte(s)

ProfileRole - 0x08 (8) |

Central)

2ddrMode : 0x00 (0) (RDDRMODE_PUBLIC)

Randomiddr = 00:00:00:-00:-00:00
Cump {Tx) -

Q0ad:01 00 FE 08 48 00 90 Qo0 00 00 0O 0O L Liio...
[5] : <Rx> - 0Z:40:25_%30

-Type o Ox04 (Event)

—EwventCode : O0x00FF (HCI_LE ExtEvent)

—-Data Length : 0xd€ (€) bytes(s)

Event : Ox0€7F (1€€3) (GAP HCI ExtentionCommandStatus)
Status : Q=00 (0} (SUCCESS)

4. Developers can scan for and connect to peripheral devices on the “Discover Connect” page.

Select Device Operation @ comi1t
Di
Read Write -~
Pairing Bonding .
Advanced Commands Raad lIl B
Over The Air Download B Ford 0 Max Records:
Scan Scan & Connect Cancel
Connection Settings
ocoMi Min Connection Interval (6-3200): 8015 (100.00ms)
o Pott Info ) -
£ Device Info: Mazx Connection Interval (6-3200): 8013 (100.00ms)
-Handle: DxFFFE Peripheral Latency (0-453): =

-BDAddr: 34:68:B5:2C:96:34 Supervision Timeout (10-3200;: | 2000/ (20000ms)

O ProfileRole:
“Central
Load Settings Get Set
Link Control
Establish Link
Pesrrd 0
Establish Cancel
Link Options

Connection Handle: | (xFFFE PHY Teminate

5. The “Advanced Commands” page provides a variety of HCl commands. For example, developers can send
“HCI_LE_Transmitter_Test” command in the following diagram.
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Select Device Operation

¥ comn

Discover Connect
Read Write
Pairing Bonding

Advanced Commands
Over The Air Download

Pt Info
& Device Info:
Handle: OFFFE

BDAddr: 34:68:B5:2C:56:34

© ProfileRole:
+Central

4.6. TI154STACK

-GATT
GAP

- GAPBondMar
GAP AE

- Ll

=-HCl

~ HCI_Reset
HCI_ReadLocalSupportedFeatures

- HCI_ReadBdAddr
HCI_ReadRSSI

~ HCI_LE_ReadLocalSupportedFeatures
HCI_LE_ReadWhiteListSize

~ HCI_LE_ClearWhiteList
HCI_LE_AddDevice ToWhite List

~ HCI_LE_Remove DeviceFromWhiteList
HCI_LE_ConnectionUpdate

~ HCI_LE_Long TermKeyRequestedReply
HCI_LE_LongTermKeyRequestedNegative Reply

- HCI_LE_ReceiverTest

estl
HCI_LE_RemoteConnectionParameterRequest Reply
~ HCI_LE_RemateConnectionParameterRequestNegative Reply
HCI_LE_SetDatalength
~ HCI_LE_SetResolvablePrivate Address Timeout
HCI_LE_ReadMaxDatalength
- HCI_LE_ReadPhy
HCI LE SetDefaultPhy

oplode ZUTE
txChanne! 0
testDatalength 0
testData 00

opCode
HCI_LE_Transmitter Test

Send Command

TI” sroyalty-free Tl 15.4-Stack is a complete software platform for developing applications that require extremely
low-power, long-range, reliable, robust and secure wireless star-topology-based networking solutions. This
section describes how to use the Tl 15.4-Stack projects with CCS.

To demonstrate the Tl 15.4-Stack demos, two modules are required.

4.6.1.

1.
2.

Open the CCS IDE.
Go to File -> Open Folder.

Import Projects into CCS
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File Edit Selection View Go Project Run

ES Create Mew Proj

@

E5 Import Proj

Mew Text File Ctri+N

New File... Ctri+Alt+N

New Folder...

Ctrl+0
Ctrl+K, Ctrl+O
Ctrl+Alt+W

Cpen File...
Open Folder...
Open Workspace from File...

Open Recent Workspace... Ctri+Alt+R

Ctrl+5S

Cirl+Alt+S

[ Exit
3. Select a custom path as the workspace.

&8 Open Folder
1 « ccs_workspace » BDE-MB1354P107xx

Organize = Mew folder

2 MName

@ Onelrive

[ This pC
Jl 30 Objects
[ Desktop
=
; Downloads
J’! Music

Documents

&= | Pictures

B videos

= Local Disk {C:) (

v O

Scripts  Terminal  Help

Search BDE-MB1334P107xx

Date medified Type

No items match your search.

Folder: |

4. Go to File -> Import Project(s).

Cancel

Select Folder
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D)5

File | Edit S i Go Project Run Scripts Terminal Help

B3 cr

E5 Import Project(s)...
New Text File
New File...

New Folder...

Open File Ctrl+0
Op Ctrl+K, Ctrl+O
Open V e from File Ctrl+Alt+W

Open Recent Workspace... Ctri+Alt+R

Ctrl+S

Ctrl+Alt+S

Auto
Preferences

B Eat

)ser Stu

zonnect your board

udio™ IDE

5. Click “Browse”, navigate to the til54stack folder. The default path is:
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30 01 _01\examples\rtos\LP_EM_CC1354P10_1\ti154stack.

6. Select “collector LP_EM_CC1354P10 1 tirtos7_ticlang” and

“sensor_LP_EM_CC1354P10 1 _tirtos7_ticlang” projects, then click ‘Finish’

Import Projects

Search directory  Cti\simplelink_cc13xx_cc26xx_sdk_8 30_01_01\examples\rtos\

[
n

discovered projects

collector_LP_EM_CC1354P10_1_freertos_ticlang
collector_LP_EM_CC1354P10_1_tirtos7_ticlang
collector_sm_2_4g_LP_EM_CC1354P10_1_freertos_ticlang
collector_sm_2_4g_|P_EM_CC1354P10_1_tirtos7_ticlang
collector_sm_LP_EM_CC1354P10_1_freertos_ticlang
collector_sm_LP_EM_CC1354P10_1_tirtos7_ticlang
coprocessor_LP_EM_CC1354P10_1_freertos_ticlang
coprocessor_LP_EM_CC1354P10_1_tirtos7_ticdlang
sensor_2_4g LP_EM_CC1354P10_1_freertos_ticlang
sensor_2_4g_LP_EM_CC1354P10_1_tirtos7_ticlang
sensor_LP_EM_CC1354P10_1_freertos_ticlang
sensor_LP_EM_CC1354P10_1_tirtos7_ticlang

Create each project in. BDE-MB1354P101xx

Browse...

Open’ ' to browse and import example projects

Cancel

Finish
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7. The two projects will be imported into the IDE.
~ BDE-MB1354P 101K

> Eqcollector_LP_EM_CC1354P10_1_tirtos7_ticlang
> B3 host_test LP_EM_CC1354P10_1_tirtos7_ticlang

3 F_=|. sensor_LP_EM_CC1354P10_1_tirtos7_ticlang
> E3simple_peripheral_LP_EM_CC1354P10_1_tirtos7_ticlang

4.6.2. Modify XOSC Cap Setting

The ‘XOSC Cap Array Delta’ parameter will impact the radio frequency offset. An inappropriate value can affect
the RF performance. Follow the steps below to set the value that fits the module.

Open “collector.syscfg” file by double-click it.
Select the “Device Configuration” item. Modify “XOSC Cap Array Delta” to 0x00.

Force VDDR
Device Configur... 1/1 Enable DCDC
RF Design
Cap Array Modification

Board J X p Array Delta 0x0

Display /3 Al ourc 48 MHz 3

DMA d RF Temperature Compensation O

3. Save the changes.
4. Similarly, modify the “XOSC Cap Array Delta” value in sensor.syscfg.

4.6.3. Modify RF Switch Configuration

The BDE-MB1354P101 module uses a different RF switch design compared to Tl LP-EM-CC1354P10-1. Follow the
steps below to adjust the RF configuration to fit the module.

1. Open syscfg file.
2. Select ‘RF’ item under “TI DRIVERS”. Modify the RF settings according to the following diagram.
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R F E:]

Use Hardware

Mone
AT"IE board

requires the

54P10 LeunchPad Band 1'
IF Antenna Switch' to be

selected (Suppress)

Mo. of Antenna Switch Control Pins @ 2

RF Coexistence
Hardware Interrupt Priority
Software Interrupt Priority

X0S5C Needed

Global Event Mask

Global Callback Function

RF Pin Symbols

RF Antenna Pin 0
RF Antenna Pin 1

O
7 - Lowest Priority

0 - Lowest Priority

RF_GlobalEventRadioPowerDown, F

rfDriverCallback
Please aee function
AntennaSwitching in
ig.c’. The antenna switching
functionality must be implementad by the

uger.

CONFIG_RF_ANTENNA_PIN_HIGH_PA

CONFIG_RF_ANTENNA_PIN_SUB_1_G

PinMux Peripheral and Pin Configuration

RF Antenna Pin 0

RF Antenna Pin 1

3. Save the changes.

DI029/27 (Header)

DIO30/28 (Header)

4. Right-click the “application” folder in the project and create a new C file named “user_rf_switch_cfg.c”.
v F_=L collector_LP_EM_CC1354P10_1_tirtos7_ticlang

> B3, Generated Source
v B3 application

> B3 collector

» B3 cui

> B3 defines

mMmain.c

> . Release

Mew File...

Mew Folder...

Add Files/Folders...
Reveal in File Explorer Ctril+Alt+P

Cpen in Integrated Terminal
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B3
simple_penpheral_LP_EM_CC1354P10_1_tirtos7_ticlang/Startup

user_rf_switch_cfg.c

5. Copy the following source code to user_rf switch_cfg.c.
#include <stddef.h>

#include <stdint.h>

#ifndef DeviceFamily CC13X4

#define DeviceFamily CC13X4

#endif

#include <ti/devices/DeviceFamily.h>

#include "ti_drivers_config.h"

#include <ti/drivers/GPIO.h>

#include <ti/drivers/rf/RF.h>

/*
* ======== Antenna switching ========
*/
/*
* ======== rfDriverCallbackAntennaSwitching ========

* Sets up the antenna switch depending on the current PHY configuration.

* Fit BDE-MB13P2 module's switch

* Truth table:

* Path DIO29 DIO30
¥ ——======== ===== =====
* Off ) )

* TX 1 )

* RX ) 1

*/

void rfDriverCallbackAntennaSwitching(RF_Handle client, RF_GlobalEvent events, void *arg)

{

if (events & RF_GlobalEventRadioSetup) {
bool sublGHz = false;

uint8_t loDivider = 0;
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/* Switch off all paths. */
GPIO write(CONFIG_RF_ANTENNA PIN SUB 1 G, 0);
GPIO write(CONFIG_RF_ANTENNA PIN_HIGH_PA, 0);

/* Decode the current PA configuration. */

RF_TxPowerTable_PAType paType = (RF_TxPowerTable_PAType)RF_getTxPower(client).paType;

/* Decode the generic argument as a setup command. */

RF_RadioSetup* setupCommand = (RF_RadioSetup*)arg;

switch (setupCommand->common.commandNo) {
case (CMD_RADIO_SETUP):
case (CMD_BLE5_RADIO_SETUP):

loDivider = RF_LODIVIDER_MASK & setupCommand->common.loDivider;

/* Sub-1GHz front-end. */
if (loDivider != 0) {
sublGHz = true;
}
break;
case (CMD_PROP_RADIO DIV SETUP):

loDivider = RF_LODIVIDER_MASK & setupCommand->prop_div.loDivider;

/* Sub-1GHz front-end. */

if (loDivider != @) {
sublGHz = true;

X

break;

default:break;

if (sublGHz) {
/* Sub-1 GHz */
if (paType == RF_TxPowerTable_HighPA) {
/* PA enable --> HIGH PA
* LNA enable --> Sub-1 GHz
*/
/* Note: RFC_GPO3 is a work-around because the RFC_GPO1 (PA enable signal) is sometimes not
de-asserted on CC1352 Rev A. */
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN_SUB 1 G, GPIO_CFG_OUTPUT, IOC_PORT_RFC_GPO0®);
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA PIN_HIGH_PA, GPIO_CFG_OUTPUT, IOC_PORT_RFC_GPO3);
} else {
/* RF core active --> Sub-1 GHz */

GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN_HIGH_PA, GPIO_CFG_OUTPUT, IOC_PORT_GPIO);
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GPIO_setConfigAndMux(CONFIG_RF_ANTENNA PIN SUB 1 G, GPIO_CFG_OUTPUT | GPIO_CFG_OUT_HIGH,
I0C_PORT_GPIO);

}

¥

else if (events & RF_GlobalEventRadioPowerDown) {
/* Switch off all paths. */
GPIO write(CONFIG_RF_ANTENNA PIN SUB 1 G, 0);
GPIO write(CONFIG_RF_ANTENNA PIN_HIGH_PA, 0);

/* Reset the IO multiplexer to GPIO functionality */

GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN_SUB_1_G, GPIO_CFG_OUTPUT, IOC_PORT_GPIO);
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN_HIGH_PA, GPIO_CFG_OUTPUT, IOC_PORT_GPIO);

4.6.4. Build and Download Project

1. Select Project -> Build All in the toolbar menu. Both the “collect” and “sensor” projects will be built.

File Edit Selection View Go Project Run Scripts Terminal Help

L[ﬁ EXPLORER Build All
1 — 2% Build Project(s) Ctrl+B
~ BDE-MB1354P101XX Clean Project(s)
~ B collector_LP_EM_CC1354P10, SR TR
» B3, Generated Source Build Configurations
~ F7 application ]
» B3 collector
» B3 cui

» B3 defines = Properties... Alt+Enter

System Configurations

Executable Actions

2. Select the “collector” project as the current active project by clicking the “collector” project root directory
in the “Project Explorer” view.

~ BDE-MB1354P101XX GERELA -
w E‘, collector_LP_EM_CC1354P10_1_tirtos7_ticlang [Releasea]
> B3,Generated Source

v BT application

» B3 collector
> B3 cui
» B defines

3. Select Run -> Debug to download the “collector” application to one of the two modules.
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4.

5.

6.

7.

Debug Target 0 - TIXDS110_Connection
Serial Mumber : XDS00009

Debug Target 1 - TIXDS5110_Connection

Debug Target 0 - 10_Connection

Debug Target 1 - TIXDS5110_Connection

If the following message occur, click “Update”.

. 36
to be atible "-|th th|4 50 -ﬂ:mr: hl|d thw Updﬂt: bu1't| to update
the firmware. DO NOT UNPLUG THE DEBUG PROBE DURING THE UPDATE.
{Emulation package 20.1.0.3372)

Cancel Update

Loading Program:
3 delLivAppData\Local\Temp\ti_cloud_storage\collector_LP_EM_CC1354
F"‘IH 1_tirtos7_ticdang.out: PT_LOAD[0]: 32752 of 110994 at 0x0

Cancel

After the update process is finished, click “Continue”.

DEBUG

Select the “sensor” project as the current active project by clicking the “sensor” project root directory in the
“Project Explorer” view.

e E‘. sensor_LP_EM_CC1354P10_1_tirtos7_ticlang [Release]
> B3, Generated Source

> B3 application

> BGyRelease
> B software_stack
> B3 targetConfigs

Select Run -> Debug to download the “sensor” application to the other module.
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Debug Target 0 - TIXDS110_Connection
Serial Number : XDS00009

Debug Target 1 - TIXDS110_Connection

bug Target 0 - TIXDS110_Connection

10_Connection

4.6.5. Running the demo

1. Opentwo instances of PuTTY. Open the correct serial ports separately using the following settings.

&2 PuTTY Configuration ? >
Category:
= Sgssion Basic options for your PUTTY session
& TE"" I_.Dglging Specify the destination you warnt to connectic
E-kall::hoard Senal line Speed
Bl [comit1] Il 115200
- Features Connectiop ype:
&~ Window (O 85H | @ Seral | 0ther: | Telmet v
- Appearance
-~ Behaviour Load. save or delete a stored session
- Translation Saved Sessions
[+~ Selection | |
- Calours
=) Connection Load
- Data
- Prowy Save
- 55H
- Serial o
- Telnet
- Rlogin
- SUPDUP Close window on exit:
() Mways () Mever (®) Only on clean exit
About Help Open Cancel

The COM number can be found in the System Device Manager:

ﬁ ¥DS110 Class Application/User UART (COM111)
AUSTID Llass Awaliary Uata Port (LUNTTE)

2. Resetthe two modules by pressing the reset button on the BDE-XDS110 board. PuTTY will display the menu.
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3. On the collector terminal side, press the right arrow key on the keyboard twice to switch to the “NETWORK
ACTIONS” menu.

5. The “NETWORK ACTIONS” menu has three actions: “FORM NWK"”, “OPEN NWK"”, “CLOSE NWK". You can
switch between these actions by pressing the left/right arrow keys.

6. Switch to “FORM NWK?”, then press the Enter key to form a Tl 15.4 network. By default, the network forbids
other devices from joining.

TI Collector

FORM NWK

7. Switch to “OPEN NWK?”, then press the Enter key to allow devices to join. At this time, the red LED on the
collector board will blink.

8. On the sensor terminal side, open the “NETWORK ACTIONS” menu and perform the “ASSOCIATE” action.
After a while, the sensor will join the network created by the collector. The red LED on the sensor board will
turn on.

Ch=0, PermitdJoi
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9. On the collector terminal side, press the Esc key to retun to the root menu, then switch to the “APP” menu
and perform the “SEND TOGGLE” action. The red LED on the sensor board will toggle.

4.6.6. Change to a Different PHY

The PHY settings are located under the ‘Tl 15.4 Stack’ item in the syscfg file.

& = Software » Tl 15.4 Stack
Tl 15.4 Stack @ 7 REMOVE ALL

Custom Enable Logging
TI 15.4 Stack 11
TI Wi-SUN FAN Stack

55 Solar Managem...

Device Role
Mode

CICICIGICRO)

Radio Configure PHY settings for radio operations

DMM Based On RF Design LP_EM_CC1354P10_1

Frequency Band

@
®

e Regulation Type

N Sub-1 GHz Frequency
Device Configur...

Phy Type 50 kbps, 2-
RF Design RF Coexistence Disabled

Custom Phy |:|
Board !
Display /3
DMA

Network Configure network settings

Developers can change the PHY settings according to their needs.
4.7. Use UniFlash to Download Firmware
In the section above, the method to flash the firmware is through debugging in the CCS IDE.

Tl provides a software tool called UniFlash, which can be used for programming on-chip flash on TI
microcontrollers and wireless connectivity devices.

4.7.1. Configure UniFlash

1. Open UniFlash.
2. Select “CC1354P10".
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~ New Configuration

@ Choose Your Device

Category: All | C2000 | mmWave | MSP | PGA | Safety | Tiva | UCD | Wireless | Bootloader | Sitara MCU

©, CC1354P10| i ox
Ll LP-EM-CC1354P10-1 LaunchPad on-Chip
## LP-EM-CC1354P10-6 LaunchPad on-Chip

[l ccizsaPi0 onchip

3. Select “Texas Instruments XDS110 USB Debug Probe”, then click the “Start” button.

~ New Configuration

@ selected Device CC1354P10

o Selected Connection: 9 Texas Instruments XDS110 USBE Debug Probe

TTECRTEWR AT S TUOVZ U ST Sy STENT TTaCe ErITOTaTor
SEGGER J-Link Emulator
Spectrum Digital XDS560VZ STM LAN Emulator
Spectrum Digital XDS560%2 STM TRAVELER Emulator
Spectrum Digital XDS560V2 STM USB Emulator
Spectrum Digital XDSPRO LAN Emulator
Spectrum Digital XDSPRO USB Emulator
Texas Instruments XDS100v2 USB Debug Probe
Texas Instruments XDS100v3 USB Debug Probe

| Texas Instruments XDS110 USE Debug Probe |

Texas Instruments XDS2xx LAN Debug Probe
Texas Instruments XDS2xx USB Debug Probe
Texas Instruments XDS2xx USB Onboard Debug Probe -

B -

4.7.2. Programming

1. Select “Program” item.

Program

Settings & Utilities
Memory

Standalone Command Line

2. Select the image file prepared for programming. By default, the image file is located in the Release/Debug
folder within the project folder in the workspace.
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Flash Image(s)
collector_LP_EM_CC1354P10_1_tirtos7_ticlang.out MD5: 33ea76277267657b15fcd710f3a10280 Size: 1.67 MB | Binary: [] %

@

3. Click the “Load Image” button to begin programming.

Available Action(s) - 1 Image Selected

Load Image Verify Image

4. When programming is successful, the console will display the following information.

[SUCCESS] Program Load completed successfully.

Please refer to the UniFlash quick start guide for more information about the UniFlash tool. Click the “Help” icon

to open the quick start guide.
© Help £ Setings

4.8. SmartRF™ Studio

SmartRF™ Studio is a Windows application that helps developers to easily evaluate the radio for all TI CC1xxx and
CC2xxx low-power RF devices.

This tool can also be used for RF certification testing.

Visit the link below to download and install SmartRF™ Studio.
https://www.ti.com/tool/SMARTRFTM-STUDIO

CALCULATION TOOL Download options

SMARTRF-STUDIO-7 — SmartRF Studio 7 application software & Notifications

Supported products & hardware

If the installer becomes locked during the download process, follow the instructions provided by TI.

@ smartrftm_studio-2.32.0.zip — 73596 K

4.8.1. Connect to the Module

1. Connect the module to the PC using the XDS debug probe.
2.  Open SmartRF Studio 7.
3.  SmartRF Studio will show that one Sub-1 GHz device is connected.
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™ Studio 7

Sub-1 GHz (1 Connected)

CC1354P10
Dual Band

4, Double-click the “CC1354P10” item.
5. Select the mode you want; in this example, the “Proprietary mode” is selected.

Select CC1354P10 mode
QO Proprietary mode

@ BLE mode

@ IEEE 802.15.4 mode

6. After clicking OK, SmartRF Studio will open a new window called “Device Control Panel”.
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L8 XDs-XDS00092 - CC1354P10_PROP - Device Control Panel

File Settings View Evaluation Board Help

packetx | P st M sip | [ Command View ] RF Parameters

Target C:

RF Design Based On: | LP_CC1354P10_1_RGZ - @ DC/DC Enable [ cap-array Tuning @

Typical Settings

= Settings for 779 - 930 MHz band
XX Bandwidth
IEEE 802.15.4, 50 kbps, 25 kHz Deviation, 2-GFSK, 100 kHz R Bandwidth
100 kbps, 25 kHz Deviation, 2-GFSK, 137 kHz RX Bandwidth
200 kbps, 50 kHz Deviation, 2-GFSK, 311 kHz RX Bandwidth

RF Parameters ﬁ

915.00000 MHz 50.00000 kBaud 25.000

RX Filter BW TX Power
kHz _ dBm Enable high output power ﬁ Mo whitening

Continuous TX | Continuous RX | PacketTX | packet RX

Packet Count: D Infinite
Length Config

Length

(dec) Packet Data

Preamble Sync word

01010101... ||[[93][ab |[51][de | [5 1] 875 ae 00 82 1c o8 03 o 4a 13 43 cd a8 8a 67 8e 21

Preamble Count: Sync Word Length: [ Address

Preamble Mode: |Send 0 as the first preamble bit - |

Add Seq. Number

(® Random | 4575 se 00 8a 1c c6 d3 fb 4a 19 43 cd a9 9a 67 8e 21
O Text

() Hex ™

Sent Packets:
Freguency:
Qutput Power:

CC1354P10_PROP, Rev. C (3.0), XDS-XDS00092 XDS110 Radio State: N.A.

4.8.2. Change the Default Settings

1. Select “LP_EM_CC1354P10_1".

Target Configuration
RF Design Based On: [ LP_EM_CC1354P10_1 - ﬁ

LP_CC1354P10_1_RGZ
LP EM_CC1354P1D_1

LP_EM_CC1354P10_6
LP_EM_CC1354P10_6, 20DBM

Gl Mallis

Typical Settings

Category
2. Select “Cap-array Tuning” and modify the “Cap Array Delta” to 0.
Cap-array Tuning Cap Array Derta: Ox00

3. Select the PHY setting.

Typical Settings

= Settings for 779 - 930 MHz band
50 kbps, 25 kHz Deviation, 2-GFSK, 100 kHz RX Bandwidth

IEEE 802.15.4, 50 kbps, 25 kHz Deviation, 2-GFSK, 100 kHz RX Bandwidth
100 kbps, 25 kHz Deviation, 2-GFSK, 137 kHz RX Bandwidth
200 kbps, 50 kHz Dewiation, 2-GFSK, 311 kHz RX Bandwidth
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4. Select the “Frequency” and “TX Power”.

RF Parameters ﬁ

815.00000 MHz 50.00000 kBaud 25.000

kHz
93.0 = | kHz 20 « dBm Enable high cutput power F @ Mo whitening -
H " H ” a“ . . .
5. Click “Customize...” button to open the “Custom Target Configuration” window.
Target Configuration
RF Design Based On: | LP_EM_CC1354P10_8, 20DBM ~ @] DC/DC Enable Cap-array Tuning Cap Array Dena 000 @]
. . . . . . . ” . “ ”
6. Modify the 1/O configuration according to the following diagrams. Click “Apply” and then click “Close”.
&8 custom Target Configuration X
~onfiguratien (TI Target)
LP_EM_CC1354P10_1 - Target Name |LP_EM_CC1354P10_1 |
Device CCA354P10 ~* | Package |[RSKE&x8 =
New Delete Create Copy As...
Front-end External Bias, Differential RF o
V0 Configuration I Output Power
IO Signal Configuration
ldle IX RX
DIO29 * | | Input/Output * | |Input tristate (Default) |  Output high * | | Output low - (X
DIO30 * | | Input/Output ¥ | |Input tristate (Defaultt) | Output low * | | Qutput high | | X
<Select V0= hd
I'0= not defined here are not configured and remaing in their reset state. Apphy Undo
Save Close Help
1/0 configuration with PA enabled
&8 custom Target Configuration X
onfiguration (Tl Target)
LP_EM_CCA354P10_1 - Target Name |LP_EM_CC1354P10_1 |
Device CC1354P10 ~ | Package RSK8x8 ~
New Delete Create Copy As...
Front-end External Bias, Differential RF ¥
1’0 Configuration I Output Power
O Signal Configuration
idie JX 2
D029 * | | Input'Output * | Input tristate (Default) = | Output low * | | Output low - | X
D030 ¥ | | Input/Output ¥ | Input tristate (Default) = | Output high * | | Qutput high * | | X
<Select V0= -
I'Os not defined here are not configured and remains in their reset state. Apphy Undo
Save Close Help
I/0 configuration with PA disabled
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4.8.3. Perform RF Test

RF testing is divided into continuous TX/RX and packet TX/RX. The signal duty cycle is 100% when operating in
continuous mode. The following steps use continuous TX as an example to demonstrate how to start the RF test.

1. Click “Continuous TX".
I CnntinuuusT}(l Continuous R | Packet TX | Packet X .

2. Enable or disable modulation of the transmitted signal. When the “Unmodulated” radio box is selected, the

signal is a carrier wave.

() Modulated (®) Unmodulated

3. Click “Start” to start transmitting the RF signal.

Output Power: 20 dBm
Channel: o

[

NOTE: Each time the RF testing type or “Enable high output power PA” setting is changed, the I/O configuration
must be reconfigured.

Please refer to the help document for more information about the SmartRF Studio tool. Click icon EZE to open
the “SmartRF Studio Help” window, then click the “Browse Complete Help Document:++” button to access the
help document.
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(BOE

&l SmartRF Studio Help

Help

The SmartRF Studio Startup Window shows an

overview of all available RF devices and
indicates which of them are physically
connected.

Right click on the device icon to access
additional infermation about the device.

Double click on the device icon to start Device
Control Panel for the RF Device.

If wou have any questions or want to give
feedback on SmartRF Studio, please visit
support.ti.com.

Browse Complete Help Document...

Revizion History...

Distribution and Disclaimer...

Check for Updates...

Close

5. Other Resources

About SmartRF Studio
SmartRF Studio 2.30.0 jbuiks2s7)

SmartRF Studio is a tool that lets
customers evaluate, test and configure
Low Power RF devices from Texas
Instruments. It iz in particular useful for
generating chip specific register values

and for finding and tuning RF parameters.

This software iz developed by Texas
Instruments to the courtesy of our
customers.

SmartRF Studio will not target Automotive
customers since it is not gualified for
Automotive devices. Customers may use
SmartRF Studie 7 for autometive devices,
but it is the customer's responsibility to
ultimatety comphy with regulatory
requirements.

Copyright (c) Texas Instruments

Access more documents by visiting the TI CC1354P10 page at the link below.
https://www.ti.com/product/CC1354P10

Additionally, refer to the guides for different components for more information about the Simplelink SDK. The
guides are located in the directory below:

C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30 _01_01\docs

For other related documentations of the module, please visit the module product page at bdecomm.com.

6. Ordering Information

Table 3. Ordering Information

Product Type

Orderable Part Number

Description

Evaluation Kit

BDE-MB1354P101xxx-K1

Evaluation kit 1 for module BDE-MB1354P101xxx, includes
1x BDE-MB13-BO, 1x BDE-LPEM, 1x BDE-XDS110, 1x USB
type C cable. Refer to module datasheet for module
variants. For example, BDE-MB1354P101UA0-K1 is the
evaluation kit 1 for module BDE-MB1354P101UAQ
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Product Type Orderable Part Number Description

Module Breakout Board BDE-MB13-BO Breakout board with BDE-MB1354P101module

Interface Evaluation Module | BDE-LPEM Launchpad evaluation module with BoosterPack interface
Debugger BDE-XDS110 XDS110 debugger

7. Revision History

Table 4. Revision History

Revision

Date

Description

V1.0

2025-5-27

First release

8. Additional Information

8.1. Trademarks

Bluetootheis a registered trademark of Bluetooth SIG, Inc.

Launchpad™ is a registered trademark of Texas Instruments.

BoosterPack™ is a registered trademark of Texas Instruments.

SmartRF™ is a registered trademark of Texas Instruments.

All trademarks are the property of their respective owners.
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Important Notice and Disclaimer

The information contained herein is believed to be reliable. BDE makes no warranties regarding the information
contain herein. BDE assumes no responsibility or liability whatsoever for any of the information contained herein.
BDE assumes no responsibility or liability whatsoever for the use of the information contained herein. The
information contained herein is provided "AS IS, WHERE IS" and with all faults, and the entire risk associated with
such information is entirely with the user. All information contained herein is subject to change without notice.
Customers should obtain and verify the latest relevant information before placing orders for BDE products. The
information contained herein or any use of such information does not grant, explicitly or implicitly, to any party
any patent rights, licenses, or any other intellectual property rights, whether with regard to such information
itself or anything described by such information.

Contact
BDE Technology Inc.

USA: 67 E Madison St, # 1603A, Chicago, IL 60603, US
Tel: +1-312-379-9589

China: B2-403, 162 Science Avenue, Huangpu District, Guangzhou 510663, China
Tel: +86-20-28065335

Website: www.bdecomm.com Email: info@bdecomm.com
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